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ВВЕДЕНИЕ 

 

Современная радиоэлектронная отрасль характеризуется крайне 

широкой номенклатурой изделий. Вместе с тем в связи с ориентацией 

современного производства на микроминиатюризацию растет слож-

ность конструкции плат. В этих условиях стремительно развиваю-

щейся промышленности и постоянно увеличивающейся сложности 

электронных устройств требования к инженерной подготовке специа-

листов становятся все более высокими. Современные изделия требуют 

приложения значительных усилий на этапах разработки, проектирова-

ния и производства, и роль эффективного проектирования возрастает с 

каждым годом. 

Проектирование – это основа создания любого технического из-

делия, и в сфере электронной промышленности эта стадия производ-

ства играет особо важную роль. Грамотно проведенное проектирова-

ние позволяет не только повысить функциональные и эксплуатацион-

ные характеристики устройства, но и снизить затраты на его производ-

ство, сократить сроки разработки и минимизировать вероятность сбоев 

и неисправностей в процессе эксплуатации. 

Ошибки на стадии проектирования могут привести к значитель-

ным затратам при производстве и эксплуатации устройства. Устране-

ние дефектов на поздних стадиях может требовать времени и средств, 

превышающих изначальный бюджет. Использование современных ин-

струментов для автоматизированного проектирования позволяет мини-

мизировать риски, связанные с человеческими ошибками, а также 

упростить и ускорить процесс создания качественной документации. 

Благодаря этому инженер может своевременно выявить и устранить 

потенциальные проблемы, избежать дорогостоящих исправлений и со-

кратить время вывода изделия на рынок. 
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Компьютерное проектирование также облегчает командную ра-

боту, так как позволяет нескольким людям одновременно работать над 

проектом, делая процесс более гибким и адаптивным к изменениям и 

корректировкам. Например, использование Altium Designer позволяет 

не только проектировать электронные схемы и платы, но и интегриро-

вать результаты работы с другими системами автоматизированного 

проектирования. Это обеспечивает непрерывность работы на всех эта-

пах, начиная от создания схем и заканчивая производством. 

Для осуществления вышеназванных процессов применяют спе-

циальные пакеты прикладных программ – системы автоматизирован-

ного проектирования. Одна из таких систем – Altium Designer, работа 

с которой рассматривается в данном лабораторном практикуме. Этот 

инструмент предоставляет инженеру широкие возможности для авто-

матизированного проектирования – от создания схемы до разработки 

и подготовки документации для производства печатных плат. Про-

граммное обеспечение позволяет реализовать комплексный подход к 

проектированию, объединяя этапы разработки в единую систему, что 

повышает точность и скорость работы, минимизирует риск ошибок и 

обеспечивает высокое качество готового изделия. 

Лабораторный практикум направлен на знакомство студентов с 

основами работы в Altium Designer. В ходе выполнения лабораторных 

работ будут рассмотрены такие этапы, как создание проекта, разра-

ботка библиотек условных графических обозначений (УГО) и посадоч-

ных мест, оформление электрических схем, трассировка печатной 

платы, а также подготовка необходимой проектной документации. 

Освоение этих навыков – важный этап в становлении компетентного 

специалиста, способного применять компьютерное проектирование 

для создания высокотехнологичных изделий, соответствующих совре-

менным стандартам. 
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Конструкторская документация 

 

Конструкторская документация – это совокупность взаимосвя-

занных документов, которые содержат полную информацию, необхо-

димую для изготовления, контроля, эксплуатации, ремонта и утилиза-

ции изделия. 

Согласно ГОСТ 2.102-2013 выделяют следующие виды конструк-

торских документов: 

– графические документы: 

● чертеж детали; 

● сборочный чертеж (СБ); 

● чертеж общего вида (ВО); 

● теоретический чертеж (ТЧ); 

● габаритный чертеж (ГЧ); 

● электромонтажный чертеж (МЭ); 

● монтажный чертеж (МЧ); 

● упаковочный чертеж (УЧ); 

● схема (по ГОСТ 2.701); 

● электронная модель детали; 

● электронная модель сборочной единицы (ЭСБ); 

● электронная структура изделия; 

– текстовые документы: 

● перечень элементов (ПЭ) 

● пояснительная записка (ПЗ); 

● таблица (ТБ); 

● расчет (РР); 

● инструкция (И); 

● технические условия (ТУ); 

● программа и методика испытаний (ПМ); 

● эксплуатационные документы (по ГОСТ 2.601); 

● ремонтные документы (по ГОСТ 2.602); 

● спецификация; 

● ведомость спецификаций (ВС); 

● ведомость ссылочных документов (ВД); 

● ведомость покупных изделий (ВП); 

● ведомость разрешения применения покупных изделий 

(ВИ); 
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● ведомость держателей подлинников (ДП); 

● ведомость технического предложения (ПТ); 

● ведомость эскизного проекта (ЭП); 

● ведомость технического проекта (ТП); 

● ведомость электронных документов (ВДЭ). 

 

Схемы 

 

Среди всего многообразия конструкторских документов особое 

внимание при проектировании электронных устройств следует уде-

лить схемам, а именно электрическим. 

По виду элементов различают следующие схемы: 

● электрические (Э); 

● гидравлические (Г); 

● пневматические (П); 

● газовые (Х); 

● кинематические (К); 

● вакуумные (В); 

● оптические (Л); 

● энергетические (Р); 

● схемы деления (Е). 

Электрическая схема – это документ, показывающий электри-

ческую взаимосвязь между компонентами и узлами изделия. Она пред-

ставляет устройство в виде условных графических обозначений ком-

понентов или составных частей изделия, соединенных между собой ли-

ниями, обозначающими электрические соединения. Электрические 

схемы – основной инструмент для описания структуры и работы элек-

тронных систем. 

Существует несколько видов электрических схем, которые отли-

чаются по уровню детализации и назначению. 

Схема структурная электрическая (Э1) – конструкторский до-

кумент, отображающий основные структурные единицы изделия, их 

назначение и взаимосвязи, предназначенный для ознакомления с об-

щими принципами построения и функционирования изделия. Струк-

турные единицы выполняют в виде прямоугольников и УГО, их наиме-

нование вписывают внутри прямоугольников или оформляют в виде 



8 

таблицы. Графическое построение схемы должно давать наглядное 

представление о последовательности взаимодействия составных ча-

стей изделия и прохождения основных потоков информации. 

Схема электрическая функциональная (Э2) отображает основ-

ные функциональные преобразования сигнала в одной из составных 

частей изделия. Схема предназначена для ознакомления с конкрет-

ными видами функционального преобразования сигнала (спектр сиг-

нала) тракта, необходимыми с учетом вида и параметров этого сигнала. 

Устройства и узлы схемы, выполняющие функциональные преобразо-

вания сигнала типа фильтрации, усиления, генерации, детектирования, 

изображают в виде УГО. 

Схема электрическая принципиальная (Э3) отображает опре-

деляющий для каждого функционального узла или устройства полный 

состав ЭРК и связи между ними, а для функциональной системы (ком-

плекса) – состав узлов и устройств и связи между ними. Схема Э3 дает 

полное представление о функционировании изделия, режимах его ра-

боты, является исходным документом для разработки конструкции из-

делия.  

Схема соединений (Э4) показывает соединения составных ча-

стей изделия и определяет провода, жгуты, кабели или трубопроводы, 

которыми осуществляются соединения, а также места их присоедине-

ний и ввода. 

Схема подключения (Э5) показывает изделие, его входные и вы-

ходные элементы (например, соединители) и подводимые к ним концы 

кабелей внешнего монтажа с данными о подключении изделия. К дан-

ным о подключении изделия относят характеристики внешних цепей. 

Схема общая (Э6) определяет составные части комплекса и их 

соединения между собой. На схеме общей изображают устройства и 

элементы, входящие в комплекс, а также провода, жгуты, кабели. 

Схема расположения (Э7) определяет относительное располо-

жение составных частей изделия, а при необходимости также жгутов, 

проводов, кабелей и т. п. 

Схема объединенная (Э0) позволяет объединять в одном кон-

структорском документе схемы разных типов. 
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Чертежи 

 

Сборочный чертеж – это документ, содержащий изображение 

сборочной единицы или изделия и другие данные, необходимые для ее 

сборки и контроля. 

Сборочный чертеж должен содержать:  

● изображение сборочной единицы, дающее представление о 

расположении и взаимной связи составных частей, соединяемых по 

данному чертежу;  

● сведения, обеспечивающие возможность сборки и контроля 

сборочной единицы;  

● размеры, предельные отклонения и другие параметры и требо-

вания, которые должны быть проконтролированы или выполнены по 

сборочному чертежу;  

● указания о характере сопряжения и методах его осуществле-

ния, если точность сопряжения обеспечивается при сборке (подбор де-

талей, их пригонка и т. д.);  

● указания о способе выполнения неразъемных соединений 

(сварных, паяных и др.); 

● номера позиций составных частей, входящих в изделие;  

● основные характеристики изделия;  

● габаритные размеры, определяющие предельные внешние или 

внутренние очертания изделия;  

● установочные размеры, по которым изделие устанавливается 

на месте монтажа;  

● присоединительные размеры, по которым изделие присоединя-

ется к другим изделиям;  

● необходимые справочные размеры и т. п.  

При изображении изделия на сборочном чертеже помимо видов 

могут применять разрезы и сечения, поясняющие форму и расположе-

ние деталей, входящих в изделие. На сборочном чертеже, как правило, 

изображения располагают в проекционной связи, что облегчает чтение 

чертежа. Отдельные изображения могут размещаться на свободном ме-

сте поля чертежа. 
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В комплект сборочного чертежа обязательно входит специфика-

ция – текстовый документ, определяющий состав сборочной единицы 

(изделия) и необходимый для ее изготовления, комплектования кон-

структорских документов и планирования запуска в производство. 

Спецификацию выполняют на отдельных листах формата А4. В специ-

фикацию вносят перечень составных частей, входящих в специфици-

руемое изделие, а также конструкторские документы, относящиеся к 

этому изделию. 

Топологический чертеж печатной платы – это детальное гра-

фическое представление, на котором показано расположение всех 

электрических соединений на печатной плате. Топологический чертеж 

включает в себя информацию о проводящих слоях печатной платы, по-

рядке их следования, масочном защитном покрытии печатной платы, 

маркировочном слое, технических требованиях. 

Топологический чертеж создают на основе принципиальной 

схемы, но он отличается от последней тем, что ориентирован на физи-

ческое расположение элементов и соединений, а не на объяснение ра-

боты устройства. 

При выполнении чертежа трассировки многослойной печатной 

платы изображения каждого слоя размещают отдельным видом на чер-

теже с указанием порядкового номера/наименования слоя. 
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Лабораторная работа № 1 

ЗНАКОМСТВО СО СРЕДОЙ ALTIUM DESIGNER. 

ПЕРВИЧНАЯ НАСТРОЙКА И СОЗДАНИЕ ПРОЕКТА 

 

Цель работы: знакомство со средой Altium Designer, изучение 

структуры проекта. 

Задание на лабораторную работу: ознакомившись с теорией, 

изучить рабочее пространство программы и произвести ее первичную 

настройку; изучить структуру проекта в Altium Designer, создать инди-

видуальный файл проекта. 

 

Краткие теоретические сведения 

 

Altium Designer – программное обеспечение для проектирования 

электронных устройств. Его используют инженеры-электронщики для 

создания электрических схем, разработки печатных плат и подготовки 

производственных файлов. 

Altium Designer позволяет: 

● разрабатывать электрические схемы, полностью прорабатывая 

все электрические связи между компонентами; 

● проектировать печатные платы разной сложности, размещая 

компоненты на ее поверхности и во внутренних слоях, а также проводя 

трассировку проводников; 

● просматривать 3D-визуализацию разрабатываемой платы для 

более наглядного представления и большей точности проектирования; 

● управлять библиотеками условных графических обозначений и 

посадочных мест компонентов, создавая собственные или используя 

готовые; 

● производить симуляцию работы электрических схем; 

● подготавливать комплект выходной документации, необходи-

мый для производства печатной платы. 

Один из недостатков среды Altium Designer – ориентация на за-

падного пользователя, из-за чего по умолчанию система работает в ан-

глийской системе мер. Соответственно, после установки для комфорт-

ной работы с программой необходимо произвести ее первичную 

настройку. 
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Первичная настройка Altium Designer 

1. Перейдите в настройки, щелкнув на кнопку , находящуюся 

в правом верхнем углу окна программы. В открывшемся окне выберите 

пункт Schematic для перехода в раздел, отвечающий за все документы 

схем и библиотек УГО. В данном пункте откройте подпункт General 

для редактирования основных настроек данного раздела.  

 

2. В графе Units переключите единицы измерения с милов на мил-

лиметры (параметр Millimeters). 

 

3. На этом же этапе рекомендуется настроить отображаемую для 

документов данного вида сетку. Сетка расчерчивает рабочую область 

программы и определяет минимальное расстояние, на которое можно 

будет переместить выбранный компонент. Таким образом, при актив-

ной сетке 5 мм в случае незначительного движения курсора компонент 

не будет перемещен, а в случае более длинного перемещения мыши 

компонент переместится на длину, кратную 5 мм. Использование сетки 

позволяет точно устанавливать компоненты. 

Для настройки сетки перейдите в подраздел Grids.  
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4. По умолчанию выставлена линейная сетка, при желании ее 

можно заменить на точечную (Grid Options > Dot Grid). Также данный 

подраздел позволяет изменить цвет сетки, но основная его возмож-

ность – предустановка размеров сетки. По умолчанию сетка привязки 

(Snap Grid), расстояние привязки (Snap Distance) и видимая сетка 

(Visible Grid) отличаются друг от друга, что может вызвать неудобства 

при использовании. Поэтому все три расстояния в одной строке в таб-

лице сделайте равными. Также следует ввести дополнительную сетку 

0,5 мм. Для этого переместите курсор в рабочее поле метрических се-

ток и щелкните правой кнопкой мыши, в открывшемся окне выбрав 

пункты Add Grid Setting > 0.5 mm. 

 

5. Помимо установки метрической системы при первом запуске 

необходимо задать шрифты по умолчанию. В соответствии с россий-

скими стандартами для электрических схем и чертежей применяют 

GOST Type B наклонный. 

Для настройки перейдите в подпункт Defaults. 

 

6. Первым необходимо изменить параметр Comment. Переклю-

чите единицы измерения на миллиметры, шрифт (Font) измените на 

GOST Type B, нажмите кнопку курсива . Переве-

дите оба символа глаза в закрытое положение  и поставьте галочку 

в строке Override Library Primitive. В итоге данный пункт должен вы-

глядеть как на рисунке ниже. 



14 

 

7. Примените аналогичные настройки к пункту Designator, за ис-

ключением значка глаза напротив пункта Value. 

 

8. Перейдите к пункту Pin и переключите единицы измерения на 

миллиметры. 

9. Установите параметры Designator и Comment равными еди-

нице. 

 

10. Параметр Pin Length равен 5 мм. 
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11. Ниже находится пункт Font Settings, включающий в себя под-

пункты Designator и Name. Установите идентичные значения в этих 

двух подпунктах. Поставьте галочку около опции Custom Settings. 

 

12. В пункте Font Settings выберите шрифт Gost Type B, 10 кегль. 

13. Нажмите кнопку, отвечающую за наклон текста. 

 

14. Повторите настройки для параметра Name. 

15. По завершении настройки нажмите Apply в правом нижнем 

углу окна настроек, после чего можете закрыть окно, выбранные пара-

метры сохранятся при перезапуске программы. 

 

Ход работы 

1. Изучите теоретические сведения. 

2. Запустите программу Altium Designer. 

3. Произведите первичную настройку программы по алгоритму, 

описанному в теоретическом разделе. 

4. Любая разработка в Altium Designer должна начинаться с созда-

ния проекта. Проект – связующее звено между всеми используемыми до-

кументами. Для создания проекта нажмите File > New > Project. 
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5. В открывшемся окне необходимо выбрать путь, по которому 

будет храниться проект. Для сохранения в памяти компьютера выбе-

рите пункт Local Projects.  

 

6. В пункте Project Type необходимо выбрать шаблон печатной 

платы. Выберите параметр Empty, если шаблоны не установлены, и  

Default, если в программе предустановлены шаблоны. 

  

7. В пункте Project Name необходимо присвоить проекту имя. Для 

удобной навигации назовите проект своей фамилией. В пункте Folder 

нужно задать путь сохранения файла. Для перехода к проводнику 

нажмите клавишу . Программа Altium Designer может работать с 

кириллицей как в названии проектов, так и в папках пути, однако во 

избежание возможных проблем рекомендуется использовать  

латиницу.  

 

Когда все параметры будут выставлены, нажмите клавишу Create. 

 

8. Теперь в рабочей области программы слева в окне Projects по-

явился созданный проект. Надпись No Documents Added рядом с ним 

говорит о том, что файл проекта не содержит никаких документов. Их 
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добавление осуществляется щелчком правой кнопкой мыши по имени 

проекта. В открывшемся окне нажмите Add New to Project, что позво-

лит выбрать тип файла, который необходимо добавить к проекту. 

  

9. Добавьте к проекту файл типа Schematic, что создаст лист элек-

трической схемы. Файлы данного типа имеют расширение *.SchDoc. 

10. Добавьте файл типа PCB, представляющий собой лист печат-

ной платы. Файлы данного типа имеют расширение *.PcbDoc. 

11. В рамках данного проекта на текущем этапе добавленных до-

кументов достаточно. Однако для дальнейшей работы ознакомьтесь с 

назначением других видов документов: 

 ActiveBOM – перечень элементов, имеет расширение 

*.BomDoc; 

 Draftsman Document – документ, хранящий чертежи, имеющий 

расширение *.PCBDwf; 

 Schematic Library – библиотека УГО, имеющая расширение 

*.SchLib. Данный документ содержит условные графические обозначе-

ния компонентов, которые могут быть использованы при разработке 

электрических принципиальных схем; 

 PCB Library – библиотека посадочных мест компонентов, ко-

торые могут быть использованы при проектировании печатной платы, 

имеет расширение *.PcbLib. 

12. Созданные документы теперь отображаются под файлом про-

екта. При этом рядом с ним горит красный индикатор, что свидетель-

ствует о том, что в проекте есть несохраненные изменения, в данном 

случае не было сохранено добавление файлов.  
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Сохранить проект можно, нажав по нему правой кнопкой мыши 

и выбрав в соответствующем всплывающем окне пункт Save либо же 

воспользовавшись горячей клавишей Ctrl + S. 

При попытке сохранения появится окно, в котором необходимо 

задать путь сохранения каждого из двух добавленных файлов. По 

умолчанию будет выбрана папка, в которую сохранен проект, следова-

тельно, редактировать расположение не нужно. При желании для удоб-

ства навигации файлы можно назвать «схема» и «плата». 

При добавлении файлов к проекту можно допустить распростра-

ненную ошибку, когда эти файлы сохраняются где-то помимо дирек-

тории проекта. Обнаружение указанной ошибки программой Altium 

Designer обозначается синей стрелкой рядом с некорректно сохра-

ненным документом. В качестве примера ниже приведен рисунок,  

на котором ошибка обнаружилась при сохранении документа 

Sheet1.SchDoc. При возникновении данной ошибки перед продолже-

нием работы следует корректно сохранить все необходимые файлы 

проекта. 
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13. Оформите отчет. 

14. Защитите работу. 

 

Требования к оформлению отчетов 

 

Все отчеты должны быть оформлены в соответствии с требова-

ниями, предъявляемыми к оформлению лабораторных работ в ВлГУ. 

Отчет должен содержать титульный лист, цель работы, при наличии – 

данные индивидуального задания, результаты работы с комментари-

ями, выводы по проделанной работе. 

Титульный лист должен содержать название министерства, пол-

ное название учебного заведения, структурного подразделения учеб-

ного заведения, название дисциплины, номер и тему лабораторной ра-

боты, должность и Ф.И.О. студента и преподавателя, город и год вы-

полнения работы. 

Весь отчет необходимо оформить шрифтом Times New Roman,  

14 кеглем. Межстрочный интервал выставить равным 1,5 пунктам. 

Отчеты, не соответствующие данным требованиям, приняты для 

защиты не будут. 

 

Контрольные вопросы  

 

1. Для чего используется среда Altium Designer? 

2. К чему приведет попытка работы с отдельными документами, 

не объединенными в проект? 

3. Какие файлы имеют расширение *.SchDoc? 

4. Какие файлы имеют расширение *.PcbDoc? 

5. Какие файлы имеют расширение *.SchLib? 

6. Какие файлы имеют расширение *.PcbLib? 

7. О чем свидетельствует индикатор рядом с именем документа? 
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Лабораторная работа № 2 

СОЗДАНИЕ БИБЛИОТЕК УГО 

 

Цель работы: ознакомление со способами организации библио-

тек в Altium Designer, создание собственной библиотеки УГО. 

Задание на лабораторную работу: создать библиотеку, содер-

жащую УГО резистора, конденсатора, дросселя, диода, транзистора. 

 

Краткие теоретические сведения 

 

Работа с Altium Designer невозможна без библиотек. Библиотека 

представляет собой документ, в котором хранятся компоненты (их 

условные графические обозначения, посадочные места, 3D-модели, 

Spice-модели для моделирования работы схем). 

Существует несколько способов ведения библиотек. 

1. Библиотеки, привязанные к проекту. В данном случае для 

каждого разрабатываемого проекта создают собственные библиотеки. 

Данный способ применим, когда всю разработку ведет один пользова-

тель с применением уникальных компонентов, которые не будут ис-

пользованы в других проектах. 

2. Интегрированные библиотеки – представляют собой файлы, 

в которых хранятся объединенные УГО, посадочные места и модели. 

При таком способе организации интегрированная библиотека устанав-

ливается в Altium Designer, что позволяет использовать входящие в нее 

компоненты в различных проектах. 

3. Управляемые библиотеки – хранятся на сервере Altium 365 и 

оттуда же управляются. Они обеспечивают централизованное хране-

ние компонентов и управление ими, что особенно полезно для команд-

ных проектов и крупных компаний. Управляемые библиотеки обеспе-

чивают контроль версий и доступ к компонентам из любого рабочего 

места. 

4. Библиотеки баз данных – подключаются к внешним базам 

данных, например Microsoft Access. 
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Ход работы 

 

1. Изучите теоретические сведения. 

2. Запустите программу Altium Designer. 

3. Откройте ранее созданный проект. Для этого нажмите File >  

> Open. 

 

Во всплывающем окне выберите файл проекта с расширением 

*.PrjPcb. 

4. Создайте в файле проекта библиотеку условных графических 

обозначений (Add New to Project > Schematic Library). 

 

5. Вы автоматически будете перемещены в редактор библиотеки, 

который перекроет собой панель проектов. Переключаться между па-

нелями можно, используя кнопки в нижней левой части экрана. Для 

того чтобы упростить этот процесс, скройте две ненужные в данный 

момент кнопки Navigator и SCHLIB. Для этого нажмите по ним правой 

кнопкой мыши и выберите пункт Close ‘Navigator’ и Close ‘SCHLIB’ 

соответственно. 
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6. Нажмите на кнопку Projects в той же области, чтобы вернуться 

обратно на панель проектов. 

7. Горящий красный флажок рядом с названием проекта свиде-

тельствует о необходимости сохранения библиотеки. Выполните со-

хранение. 

 

8. После того как библиотека будет сохранена, можно приступать 

к созданию компонентов. Вернитесь к редактору библиотек, нажав 

кнопку SCH Library в нижнем левом углу. 

9. Библиотека содержит множество компонентов. Все из них при-

ведены в панели библиотеки. При создании новой библиотеки в ней 

будет по умолчанию создан один компонент с названием Component_1. 

Создайте на его месте условное графическое обозначение резистора. 

 

10. В нижней левой части экрана редактора библиотек УГО пока-

заны три числовых значения. 

 

Первые два – координаты курсора мыши. Третье – текущий раз-

мер сетки. Размер сетки будет последовательно переключаться между 

ранее заданными значениями при нажатии на клавишу G на клавиа-

туре. Установите значение сетки равным 5 мм. 

11. При создании УГО компонента ему необходимо добавить вы-

воды, которые в англоязычной версии программы называются pin. На 

панели инструментов в верхней части экрана нажмите на кнопку  

Place Pin. 
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12. При нажатии на кнопку на экране появится нужный нам эле-

мент. Но перед его размещением необходимо задать некоторые его па-

раметры. Нажатие на клавишу Tab клавиатуры откроет панель пара-

метров (Properties) в правой части экрана. 

13. В пункте Designator проставьте нумерацию выводов, ей стоит 

уделить особое внимание, так как в будущем это будет важным этапом 

при объединении УГО и посадочного места компонента. Начинать ну-

мерацию следует с единицы. 

14. В пункте Comment оставьте описание выводов. Например, их 

назначение у микросхемы и анод или катод у диода. Поскольку у рези-

стора есть всего два вывода с одинаковыми свойствами, в описании 

следует продублировать значение параметра Designator (1). 

15. Как можно заметить, введенные значения параметров Desig-

nator и Comment отображаются рядом с выводом в рабочей области. 

Скройте их, нажав на клавишу  рядом с соответствующим парамет-

ром. 

16. В пункте Pin Length выставите длину вывода. Данное значе-

ние не регламентируется ГОСТом. Но для удобства примем значение  

5 мм за стандартную длину вывода всех компонентов. 

17. Настроенное окно параметров вывода должно выглядеть сле-

дующим образом. 
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18. Когда все параметры вывода будут выставлены, нажмите кла-

вишу Esc на клавиатуре, что снимет с паузы размещение вывода. 

19. При размещении вывода в рабочей области обратите внима-

ние на некоторые моменты. Во-первых, сам вывод выглядит несиммет-

рично: один из его концов имеет полупрозрачный символ, который 

обозначает точку электрической привязки (к этой точке в дальнейшем 

будут подключаться электрические соединения), следовательно, этот 

конец вывода должен быть направлен от компонента. Поворот любого 

объекта на 90 градусов в Altium Designer можно осуществить нажатием 

на клавишу Space клавиатуры. Также возможно инвертировать объект 

по горизонтальной оси нажатием на клавишу X или по вертикальной 

оси нажатием на клавишу Y. 

20. Во-вторых, рабочее поле представляет собой прямоугольную 

систему координат, и любое дальнейшее размещение созданного ком-

понента будет происходить относительно нулевых координат этой си-

стемы, следовательно, элементы компонента необходимо размещать от 

начала координат. 

21. Убедившись, что вывод правильно ориентирован, установите 

его нажатием на левую кнопку мыши. 

22. При этом в рабочей области появится следующий вывод с та-

кими же параметрами, как у первого, автоматически пронумерованный 

следующим порядковым номером. Второй вывод также необходимо 

правильно сориентировать и расположить его на расстоянии двух кле-

ток при активной сетке 5 мм от первого вывода. 

23. Третий вывод для УГО резистора не нужен, поэтому отмените 

его автоматическое размещение нажатием на правую кнопку мыши. 

24. Когда выводы размещены, их параметры все еще можно редак-

тировать. Для этого дважды кликните левой кнопкой мыши по соответ-

ствующему компоненту. Перейдите таким образом к параметрам вто-

рого созданного вывода и убедитесь в том, что автоматически выстав-

ленные параметры Designator и Comment приняли нужные значения. 

25. Теперь необходимо начертить основную часть УГО рези-

стора. Согласно ГОСТу, это прямоугольник с размерами 10 мм по го-

ризонтали и 4 мм по вертикали. Для построения воспользуйтесь кноп-

кой  на панели инструментов. При нажатии на нее в рабочей области 

появится возможность начертить нужный объект. Предварительно 

установите размер сетки равным 1 мм. 
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26. Находясь в рабочей области программы, можно изменять ее 

масштаб. Для этого нажмите и удерживайте кнопку колесика мыши и 

перемещайте саму мышь вперед или назад. Таким образом, созданный 

резистор должен иметь следующий вид. 

 

27. Теперь необходимо ввести некоторые параметры созданного 

компонента. Для этого, когда мышь находится в свободном поле, от-

кройте панель Properties в правой части экрана. 

28. Параметр Design Item ID – это имя компонента, под которым 

последний будет храниться в библиотеке. Назовем его «Резистор по-

стоянный». 

29. В пункте Designator введите позиционное обозначение эле-

мента. В случае резистора – R. Причем после буквы R следует поста-

вить знак вопроса, чтобы в дальнейшем для компонентов можно было 

выполнить автонумерацию.  

30. В пункте Comment указывают дополнительную информацию 

о компоненте. В нашем случае она не нужна, поэтому скройте этот 

пункт нажатием на кнопку . 

31. Таким образом, панель Properties данного резистора должна 

выглядеть следующим образом. 
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32. Когда первый компонент создан, можно перейти к следую-

щему. Для этого, находясь в панели SCH Library, нажмите кнопку Add 

(добавить), чтобы создать новый компонент в данной библиотеке. 

 

33. В открывшемся окне задайте имя компонента. 

 

34. По алгоритму, представленному выше, создайте условное гра-

фическое обозначение постоянного конденсатора. 

 

Буквенный код конденсатора на схеме – C. 

35. По алгоритму, представленному выше, создайте условное гра-

фическое обозначение дросселя. 

 

Буквенный код дросселя на схеме – L. 

36. По алгоритму, представленному выше, создайте условное гра-

фическое обозначение выпрямительного диода. 

 

5

4
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36.1. Буквенный код полупроводникового диода на схеме – VD. 

36.2. В отличие от ранее рассматриваемых неполярных компо-

нентов, диод обладает полярностью, т. е. его выводы не одинаковые. 

Поэтому первый вывод в пункте Designator необходимо обозначить 

буквой А (анод), а второй – буквой К (катод). 

37. По алгоритму, представленному выше, создайте условное гра-

фическое обозначение биполярного PNP-транзистора. 

 

37.1. Буквенный код транзистора – VT. 

37.2. Как и в случае с диодом, каждый из выводов транзистора уни-

кален, следовательно, при размещении выводов в пункте Designator 

необходимо обозначить их буквами Б, К и Э (база, коллектор и эмиттер). 
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38. Выполните сохранение созданной библиотеки. 

39. Оформите отчет. 

40. Защитите работу. 

Контрольные вопросы  

1. Какие существуют способы ведения библиотек? 

2. В чем преимущества интегрированной библиотеки перед биб-

лиотекой проекта? 

3. Что такое точка электрической привязки? 

4. Почему точка электрической привязки не может быть направ-

лена к компоненту? 

5. Что такое УГО? 

 

Лабораторная работа № 3 

СОЗДАНИЕ БИБЛИОТЕК ПОСАДОЧНЫХ МЕСТ 

 

Цель работы: изучение возможностей редактора библиотек по-

садочных мест. 

Задание на лабораторную работу: создать библиотеку посадоч-

ных мест компонентов согласно индивидуальному варианту (табл. 1) и 

объединить их с УГО компонентов, представив результат в виде инте-

грированной библиотеки.  

Таблица 1 

Индивидуальные варианты 

Вариант Типоразмер резистора, дюйм Типоразмер конденсатора, дюйм 

1 0402 0603 

2 0603 0805 

3 0805 1206 

4 1206 1812 

5 1812 0402 
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Размеры резисторов и конденсаторов представлены в табл. 2. 

Таблица 2 

Размеры резисторов и конденсаторов 

Типоразмер, 

дюйм 

Типоразмер, 

мм 
L, мм H, мм W, мм а, мм 

0402 1005 1.0 0.35 0.5 0.2 

0603 1608 1.6 0.45 0.8 0.3 

0805 2012 2.0 0.50 1.2 0.4 

1206 3216 3.2 0.55 1.5 0.5 

1812 4532 4.5 0.55 3.2 0.6 

 

Краткие теоретические сведения 

 

Библиотеки посадочных мест позволяют создать модели компо-

нентов для трассировки печатных плат. Документы типа PCB, к кото-

рым относятся посадочные места (footprint), могут содержать множе-

ство слоев, каждому из которых соответствует свой собственный цвет. 

1. Top Layer (красный) – медный проводящий слой на поверхно-

сти платы. Этим слоем оформляют места, на которые припаивают ком-

поненты платы, а также контактные дорожки. 

2. Top Solder (фиолетовый) – вскрытие в паяльной маске. Боль-

шинство печатных плат покрывают паяльной маской, которая защи-

щает поверхность платы от попадания припоя. Для возможности пайки 

на поверхности платы необходимо оставить места, не покрытые паяль-

ной маской. Именно за эти открытые места и отвечает слой Top Solder. 

3. Top Overlay (желтый) – шелкография на поверхности платы. 

Этот слой не проводит электрический ток и служит визуальной под-

сказкой для монтажника; с помощью шелкографии обозначают пози-

ционный номер компонента, его контур, полярность выводов (при 

наличии). 

4. Top Paste (темно-серый) – слой, используемый для нанесения 

паяльной пасты на верхний слой платы для компонентов SMT. 

Слово Top на некоторых слоях означает их нахождение на по-

верхности платы. Вместо него может стоять слово Bottom, означающее 

нахождение слоя на нижней стороне платы.  

Так, например, Bottom Layer (синий) – медный проводящий слой 

на нижней стороне платы. 
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5. Mechanical 1 – Mechanical 16 – конструктивные слои, которыми 

обозначают контур платы/компонента, вырезы в нем и прочие кон-

структивные особенности. 

6. Keep-Out Layer (полупрозрачный розовый) – слой, определяю-

щий области, где нельзя размещать компоненты и трассировку. 

7. Drill Drawing Layer – слой, содержащий информацию о распо-

ложении отверстий. 

8. Drill Guide Layer – слой, помогающий при создании чертежей 

для сверловки. 

9. Multi-Layer (светло-серый) – слой, охватывающий все слои 

платы. 

 

Ход работы 

 

1. Изучите теоретические сведения. 

2. Запустите программу Altium Designer. 

3. Откройте ранее созданный проект. 

4. Создайте в файле проекта библиотеку условных графических 

обозначений (Add New to Project > PCB Library), после чего сохраните 

документ и файл проекта. 

 

5. Как и в случае работы с библиотекой УГО, переключаться 

между библиотекой и проектом можно с помощью кнопок в нижней 

левой части экрана, откуда снова будет целесообразно убрать неис-

пользуемые окна. 
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6. На панели PCB Library отображаются все посадочные места 

данной библиотеки. По умолчанию в ней создается один компонент с 

названием PCBCOMPONENT_1. Измените его, дважды нажав левой 

кнопкой мыши на этот компонент. 

 

7. В открывшемся окне введите типоразмер резистора согласно 

варианту, после чего нажмите кнопку OK. 

 

8. Далее необходимо перевести рабочее пространство в метриче-

скую систему. Для этого нажмите клавишу Q клавиатуры. После этого 

координаты курсора и сетка в нижнем левом углу будут отображаться 

в миллиметрах.  

 

9. Далее необходимо настроить сетку. Ее настройка при работе с 

документами типа PCB, как и при работе с документами типа  

Schematic, осуществляется нажатием на клавишу G клавиатуры. Однако 

в данном случае сетка не переключается последовательно, вместо этого 

появляется всплывающее окно, предлагающее установить шаг сетки. 

Его необходимо выбрать, опираясь на размеры разрабатываемого поса-

дочного места. Шаг сетки может быть изменен в любой момент. 
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10. Создание посадочного места следует начинать с размещения 

контактных площадок. Для этого на панели инструментов нажмите на 

кнопку  Place Pad. 

11. Перед непосредственным размещением контактной площадки 

необходимо задать ее параметры, для этого нажмите клавишу Tab кла-

виатуры. 

12. В открывшемся окне параметров Properties в пункте Designa-

tor обозначьте контактную площадку. Для корректного объединения 

создаваемого посадочного места с ранее созданным УГО необходимо, 

чтобы пункты Designator контактных площадок и выводов УГО совпа-

дали, т. е. первая контактная площадка обозначается цифрой 1. 

 

13. Выберите слой, на котором будет располагаться контактная 

площадка. Поскольку создается посадочное место для поверхностного 

монтажа, в пункте Layer выберите Top Layer для размещения контакт-

ной площадки на верхней стороне платы. 

 

14. Далее необходимо задать форму контактной площадки. Для 

этого в пункте Shape выберите опцию Rectangular. 

 

15. Теперь следует задать размеры контактной площадки рези-

стора согласно варианту. Для этого в пункте (X/Y), находящемся под 

пунктом Shape, введите значения a и W согласно варианту. Обратите 

внимание на то, что при вводе размеров в Altium Designer необяза-

тельно указывать единицы измерения, а также «0» при вводе числа, не 

превышающего единицы. Таким образом, при вводе «.2» программа ав-

томатически преобразует результат в «0.2 mm». 

16. После того как все параметры введены, выйдите из активной 

паузы нажатием на клавишу Enter клавиатуры. 

17. Затем разместите контактную площадку в начале координат, 

обозначенном белым кругом .  

При необходимости изменить масштаб рабочего пространства 

нажмите и удерживайте кнопку колесика мыши, при этом двигая саму 

мышь вперед или назад. 
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18. После размещения первой контактной площадки программа 

автоматически будет готова к размещению второй с аналогичными раз-

мерами. Разместите ее на необходимом расстоянии от первой в соот-

ветствии с размерами компонента по варианту. 

При размещении первой контактной площадки на координа-

тах (0; 0) координаты второй площадки могут быть высчитаны как раз-

ность параметров L и a (𝐿 − 𝑎). В состоянии активной паузы коорди-

наты контактной площадки могут быть заданы в пункте (X/Y). 

 

19. После размещения контактных площадок обозначьте контур 

компонента. Для этого на нижней панели выберите слой Mechanical 1. 

 

20. На панели инструментов верхней части экрана наведите курсор 

на инструмент Place Line  и нажмите на него правой кнопкой мыши. 

21. В открывшемся окне выберите пункт Rectangle. 

 

22. В рабочей области появится возможность разместить прямо-

угольник на слое Mechanical 1. Наведите курсор на левый верхний угол 

первой контактной площадки (красная область), щелкните левой кнопкой 

мыши, затем переместите мышь в правый нижний угол второй контактной 

площадки. Перед тем как непосредственно разместить контур компо-

нента, нажмите на клавишу Tab клавиатуры и установите толщину кон-

тура Track Width пропорционально размерам создаваемого компонента. 
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23. Теперь необходимо создать шелкографию компонента. Для 

этого перейдите на слой Top Overlay. 

 

24. На панели инструментов выберите инструмент Place  

Rectangle . 

25. По аналогии с контуром резистора начертите прямоугольник, 

вершины которого лежат на крайних точках контактных площадок. 

 

26. Для трассировки печатной платы достаточно создать компо-

нент такого вида, однако для составления чертежей необходимо опре-

делить размеры компонента в пространстве. Возможности Altium De-

signer в этом направлении ограничены, однако для создания модели 

простого резистора их достаточно. Для создания тела компонента 

щелкните правой кнопкой мыши по инструменту 3D Body  на па-

нели инструментов. 

27. В открывшемся окне выберите Extruded 3D Body. 

 

28. В рабочей области последовательно начертите прямоуголь-

ник с вершинами, совпадающими с контуром компонента. 
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29. После установки четвертой вершины перейдите в режим ак-

тивной паузы нажатием на клавишу Tab. 

30. В открывшемся меню необходимо обратить внимание на два 

пункта: Overall Height и Standoff Height. Первый отвечает за общую вы-

соту компонента; второй – за то, насколько компонент будет поднят 

относительно нулевых координат. Поскольку создаваемый компонент 

предназначен для поверхностного монтажа, он не будет приподнят над 

поверхностью, следовательно, параметр Standoff Height будет равен 

нулю. Общая же высота компонента указана в индивидуальном вари-

анте, следовательно, параметр Overall Height принимается равным па-

раметру H. 

 

31. Нажатием на клавишу Enter выйдите из состояния активной 

паузы. 

32. Правой кнопкой мыши отмените установку пятой вершины 

модели компонента. 

33. Снова одним нажатием на правую кнопку мыши отмените 

установку еще одной модели компонента. 

34. Созданный компонент должен выглядеть следующим образом. 
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34.1. Нажатием на клавишу «3» клавиатуры вы можете перейти в 

3D-режим. 

 

34.2. Находясь в 3D-режиме (и любом другом режиме), вы мо-

жете перемещаться по рабочему пространству с зажатой правой кноп-

кой мыши. 

34.3. Находясь в 3D-режиме, вы можете вращать рабочую об-

ласть, одновременно зажав клавишу Shift клавиатуры и правую кнопку 

мыши. 

34.4. Для возврата к двумерному отображению компонента 

нажмите клавишу «2» клавиатуры. 

35. Когда компонент будет полностью готов, сохраните библио-

теку. 

36. После сохранения привяжите созданное посадочное место ре-

зистора к его УГО. Для этого откройте библиотеку УГО (файл с рас-

ширением *.SchLib). 

 

37. В библиотеке перейдите к УГО резистора. 

 

38. В нижней области экрана нажмите на кнопку Add Footprint. 

39. В открывшемся окне нажмите на кнопку Browse . 

40. На экране появится библиотека посадочных мест. Выберите 

единственное созданное посадочное место 0402 и нажмите кнопку OK. 
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41. В следующем меню также нажмите ОK. 

42. Теперь к данному УГО привязано посадочное место типораз-

мера, что показано в нижней части экрана. 

 

43. Перейдем к созданию посадочного места конденсатора. От-

кройте панель PCB Library. 

Altium Designer обладает собственным редактором посадочных 

мест, который может построить модель компонента по заданным пара-

метрам. Воспользуемся данным функционалом при создании модели 

конденсатора. Для этого в верхней области экрана откройте  

Tools > IPC Compliant Footprint Wizard. 

 

44. В приветственном окне нажмите кнопку Next. 
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45. В окне выбора типа создаваемого компонента выберите оп-

цию Chip, включающую в себя двухвыводные пассивные компоненты 

для поверхностного монтажа. 

 

46. В открывшемся окне введите параметры согласно варианту. 

Параметры в программе задают с учетом погрешности. Для параметров 

L, H и W примите погрешность равной ±0.1 мм, для параметра a ±0.05 мм. 

Вводимые параметры для типоразмера 0603 приведены на ри-

сунке. 
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47. Продолжайте нажимать кнопку Next до тех пор, пока перед 

вами не появится окно, в котором необходимо задать имя компонента. 

В качестве имени используйте типоразмер конденсатора по варианту. 

 

48. В следующем окне выберите место, куда будет сохранен до-

кумент. Для того чтобы сохранить модель конденсатора в создаваемой 

библиотеке, установите галочку в пункте Current PcbLib File. 

 

49. Затем снова нажмите кнопку Next. И в заключительном окне 

нажмите кнопку Finish. 

 

Таким образом, в разрабатываемой библиотеке появится еще 

один компонент. 

 

 

50. Выполните сохранение библиотеки и привяжите созданное 

посадочное место к УГО конденсатора в библиотеке SchLib. 

51. Перейдем к созданию модели дросселя для выводного мон-

тажа. Находясь в библиотеке посадочных мест, нажмите кнопку Add 

для создания нового компонента. 
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52. В списке компонентов появится новая строка. 

 

Дважды щелкните по ней левой кнопкой мыши и в появившемся 

окне введите название компонента «Дроссель». 

53. Создание посадочного места снова следует начинать с разме-

щения контактных площадок (инструмент Place Pad ). 

54. Перейдя в режим активной паузы (Tab), настройте параметры 

контактной площадки. В графе Designator установите значение 1. 

55. Так как создается компонент для монтажа в отверстия, выбе-

рите слой Multi-Layer. 

 

56. Введите параметры отверстия. Первой необходимо задать 

круглую форму (Shape > Round). 

57. Введите размеры области, покрытой медью, для этого в 

пункте (X/Y), расположенном сразу после пункта Shape, введите значе-

ния 1.2 и 1.2. 

 

58. Далее необходимо установить диаметр отверстия. Для этого в 

строке Hole Size введите значение 0.7. 

 

59. После ввода всех параметров выйдите из режима активной па-

узы (Enter) и установите контактную площадку в начале координат. 
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60. Вторую контактную площадку установите в точке с коорди-

натами (8.5; 0). 

 

61. Начертите слой шелкографии вокруг компонента. Для этого, 

перейдя на слой Top Overlay, начертите прямоугольник с размерами, 

представленными на рисунке. 

 

62. Разместите слой шелкографии вокруг компонента. 

 

63. Как и в случае с УГО резистора, этих действий будет доста-

точно для того, чтобы созданное посадочное место могло использо-

ваться при трассировке печатной платы. Однако для качественного ис-

полнения чертежей необходимо создать трехмерную модель компо-

нента. Функционала Altium Designer недостаточно для создания слож-

ной объемной модели, однако программа умеет работать с файлами 

типа *.step, которые хранят в себе всю информацию о внешнем виде 

объекта. Для продолжения работы получите у преподавателя step-файл 

дросселя. Сохраните файл в директории проекта. 
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64. Для открытия step-файла дросселя воспользуйтесь инструмен-

том Place 3D-Body . Во всплывающем окне укажите путь к step-

файлу, а затем выберите его. 

 

65. Перейдите в режим активной паузы. Для правильной ориен-

тации модели поверните ее на 90 градусов по оси X. Для этого в пункте 

Rotation X° установите значение 90. 

66. Затем задайте высоту подъема компонента 2 мм. Для этого в 

пункте Standoff Height введите «2». 

 

67. Разместите компонент в рабочей области. 

68. После его размещения появится возможность задать точные 

координаты модели. Для этого дважды щелкните по ней левой кнопкой 

мыши, чтобы снова перейти к окну параметров (Properties). В пункте 

Location введите координаты (4.25; 0). 

 

69. В результате будет создано посадочное место, включающее в 

себя трехмерную модель дросселя. 
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70. Сохраните библиотеку и выполните привязку посадочного 

места к УГО. 

71. Перейдем к созданию посадочного места диода. Для этого со-

здайте новый компонент в библиотеке и переименуйте его. 

 

72. Для упрощения задачи возьмем за основу созданное посадоч-

ное место резистора. Для этого откройте названное посадочное место. 

Находясь в рабочей области, нажмите комбинацию клавиш Ctrl + A для 

выделения всех объектов рабочей области. 

 

73. Затем нажмите комбинацию клавиш Ctrl + C для копирования 

выделенных объектов. Далее выполните щелчок левой кнопкой мыши 

по одному из выделенных объектов. 

74. После того как компонент был скопирован в буфер обмена, 

вернитесь к последнему созданному компоненту (диоду). Находясь в 

рабочей области, нажмите комбинацию клавиш Ctrl + V для размеще-

ния компонента. 

75. Для того чтобы данную модель можно было использовать как 

диод, необходимо внести некоторые изменения, главным из которых бу-

дет переименование контактных площадок. У диода необходимо соблю-

сти полярность. Для этого наведите мышь на первую контактную пло-

щадку и произведите двойной щелчок. В появившемся окне необходимо 
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уточнить, параметры какого компонента требуется открыть. Выберите 

контактную площадку Pad. 

 

76. В панели Properties в пункте Designator замените значение 1 

на А (анод). 

77. Аналогично переименуйте вторую контактную площадку на 

К (катод). 

78. Далее необходимо визуально обозначить полярность контакт-

ных площадок. Общепринятое обозначение для диодов – вертикальная 

черта в области катода. Начертите ее, перейдя на слой Top Overlay и 

воспользовавшись инструментом Place Line. 

 

79. Сохраните библиотеку и выполните привязку посадочного 

места к УГО. 

80. Создайте посадочное место транзистора с помощью встроен-

ного редактора. Для этого перейдите на панель PCB Library. Восполь-

зуйтесь редактором Tools > IPC Compliant Footprint Wizard. 

81. Выберите транзистор типа SOT143. 

 

82. Оставив все параметры по умолчанию, дойдите до этапа ввода 

имени. Переименуйте компонент в «Транзистор SOT-143». 
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83. Следующим шагом выберите опцию сохранения – в текущую 

библиотеку. 

 

84. Перейдите к заключительному шагу нажатием на кнопку Next. 

85. Завершите работу с редактором посадочных мест. 

86. Посадочное место транзистора создано, однако для его кор-

ректной привязки к УГО необходимо изменить названия контактных 

площадок. Переименуйте контактные площадки в соответствии с ри-

сунком. 

 

87. Сохраните библиотеку, выполните привязку посадочного ме-

ста к УГО. 

88. На данном этапе было создано две библиотеки, компоненты 

которых можно использовать лишь в пределах одного разрабатывае-

мого проекта. Об этом свидетельствует отображение библиотек в де-

реве проекта. 
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89. Для того чтобы сделать данную библиотеку более универ-

сальной, необходимо преобразовать ее в интегрированную библио-

теку. Для этого создайте файл интегрированной библиотеки  

(File > New > Library > Integrated Library). 

 

90. Затем перетащите оба файла библиотек из дерева проекта в 

дерево интегрированной библиотеки. 

 

91. Сохраните файл проекта. 

92. Сохраните файл библиотеки в вашу директорию на компью-

тере, назвав ее своей фамилией. 

 

93. Кликните правой кнопкой мыши по файлу интегрированной 

библиотеки и выберите опцию Compiled Integrated Library. 

 

93.1. Для проверки правильности выполненных действий перей-

дите к файлу схемы в составе проекта. 

93.2. На панели инструментов выберите Place Part . 
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93.3. В открывшемся окне разверните окно библиотек. В предло-

женном списке должна отображаться созданная библиотека. 

 

93.4. В случае отсутствия библиотеки в списке или при необхо-

димости установки новой интегрированной библиотеки, находясь в 

меню компонентов, необходимо нажать кнопку . А в открывшемся 

окне выбрать опцию File-based Libraries Preferences. 

 

93.5. В открывшемся окне нажатие на кнопку Install даст возмож-

ность указать путь к библиотеке, которую необходимо установить. Вы-

бор соответствующего файла даст возможность использовать компо-

ненты из данной библиотеке при работе над любым проектом. 

 

94. Оформите отчет. 

95. Защитите работу. 

 

Контрольные вопросы  

 

1. Что означают цифры типоразмера 0402? 

2. Для чего используют слой Top Layer? 

3. Для чего используют слой Top Overlay? 

4. Для чего используют слой Bottom Layer? 

 

Лабораторная работа № 4 

РАЗРАБОТКА РАМКИ ЛИСТА А3  

СОГЛАСНО ТРЕБОВАНИЯМ ГОСТа 

 

Цель работы: получение навыков работы с документами фор-

мата *.SchDoc в Altium Designer. 

Задание на лабораторную работу: начертить рамку листа фор-

мата А3, выполненную по требованиям ГОСТа. 
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Краткие теоретические сведения 

 

Конструкторские документы необходимо выполнять в соответ-

ствии с перечнем четких требований. Одно из таких – выполнение 

электрических схем на листах, обрамленных в рамку, содержащую ос-

новную надпись и дополнительные графы. Требования к рамке пред-

ставлены в ГОСТ 2.104-2006. 

Для листов, размер которых превышает формат А4, рамка оформ-

ляется в зависимости от размеров листа, основная надпись при этом 

имеет фиксированные размеры. Для листа формата А3 рамка и основ-

ная надпись примут следующие размеры.  

 

Основную надпись следует расчертить и заполнить следующим 

образом. 
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Ход работы 

 

1. Изучите теоретические сведения. 

2. Запустите программу Altium Designer. 

3. Получите у преподавателя файл, необходимый для работы. Со-

храните данный файл в директорию ранее созданного проекта. 

4. Откройте файл средствами Altium Designer (File > Open). 

5. В открывшемся рабочем пространстве, представляющем собой 

лист формата A3, начертите рамку. Для этого воспользуйтесь инстру-

ментом Place Line на панели инструментов . 

6. Перед размещением рамки перейдите в режим активной паузы 

(Tab) и установите среднюю толщину линии (Medium) в пункте Line. 

 

7. Выйдите из режима активной паузы и разместите первую вер-

шину в точке с координатами (20; 5), затем в точках (415; 5), (415; 292) 

и (20; 292). 

8. Аналогичным образом начертите рамку основной надписи, ис-

пользуя инструмент Line с вершинами в точках (230; 5), (230; 60) и 

(415; 60). Таким образом, разметка листа примет следующий вид. 
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9. Теперь необходимо начертить поля основной надписи. Не из-

меняя толщину линий, начертите четыре вертикальные черты на рас-

стоянии 17, 40, 55 и 60 мм от левой границы основной надписи. 

 

10. Начертите горизонтальную черту на расстоянии 15 мм от 

верхней границы основной надписи. 

 

11. Используя размеры, приведенные в теоретических сведениях, 

разместите все линии основной надписи данной толщины. 

 

12. Начертите оставшиеся линии основной надписи, используя 

линии малой толщины. 
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13. Таким образом, рамка основной надписи со всеми полями ока-

жется начерчена. 

 

14. Используя средний размер линий, начертите дополнительные 

графы, расположенные в левой области листа, с размерами, указан-

ными в теоретической части. 

 

15. Далее добавьте текст в основную надпись и дополнительные 

графы. Для этого воспользуйтесь инструментом Place Text String . 

Перейдя в режим активной паузы, установите шрифт Gost Type A, 18 

кегль, черный цвет. 

 

16. В поле Text введите «Разраб.» 
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17. Разместите надпись в соответствующей ячейке. 

 

17.1. На данном этапе следует обратить внимание на то, что раз-

мещенная надпись имеет начертание, не соответствующее шрифту 

Gost Type A. Это особенность работы Altium Designer с нестандарт-

ными шрифтами, и при сохранении документа в формате PDF текст 

начнет отображаться корректно. Для предпросмотра того, как будет 

выглядеть текст при корректном отображении шрифта, можно выпол-

нить ряд действий. 

17.2. Нажмите на уже размещенный текст левой кнопкой мыши. 

 

17.3. Нажмите комбинацию Ctrl + C на клавиатуре, чтобы скопи-

ровать текстовое поле.  

17.4. Нажмите комбинацию Ctrl + V на клавиатуре, чтобы вста-

вить скопированный текст. При выполнении данных действий появля-

ется возможность увидеть корректное начертание и размер текстового 

поля, что может быть полезно при размещении надписей, которые в 

искаженном виде превышают соответствующую рамку. 

 

18. Добавьте оставшиеся текстовые поля основной надписи. 
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19. Добавьте надписи дополнительных граф. 

 

20. Оставшиеся ячейки заполняют на этапе разработки документа 

(схемы или чертежа), поэтому необходимо предусмотреть возмож-

ность редактирования данных полей. Для этого откройте параметры 

создаваемой рамки, нажав кнопку Properties в правой части экрана.  

 

21. Далее перейдите на вкладку Parameters. 

 

22. На экране отобразится перечень параметров, которые можно 

использовать для заполнения оставшихся полей, однако для удобства 

в данный список будут добавлены параметры на русском языке. В ниж-

ней части списка нажмите кнопку Add и в появившемся окне выберите 

опцию Parameter. 
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23. В списке появится новый параметр. 

 

24. Нажатие левой кнопкой мыши по параметру даст возмож-

ность отредактировать его название. Переименуйте параметр на «Раз-

работал». 

 

25. Аналогичным образом добавьте параметры «Проверил», 

«Нормоконтроль», «Утвердил», «Децимальный номер», «Название», 

«Подпись 1», «Подпись 2», «Лист», «Всего листов». 

 

26. Затем следует разместить данные параметры в соответствую-

щих полях. Для этого выберите инструмент Place Text String . За-

дайте такие же параметры шрифта, как на предыдущих шагах. 

27. В поле «Текст» следует написать «=Разработал», после чего 

разместить текст в соответствующей ячейке. 
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28. Аналогичным образом разместите поля с параметрами «Про-

верил», «Нормоконтроль», «Утвердил», «Лист» и «Всего листов». 

  

29. Остальные параметры разместите как на рисунке, в следую-

щем порядке: «Децимальный номер», «Название», «Подпись 1», «Под-

пись 2». Причем для первых двух параметров при размещении необхо-

димо изменить кегль на 28 и 24 соответственно, а выравнивание сде-

лать по центру для всех четырех параметров. 

 

 

30. Добавьте последний параметр «Децимальный номер», выста-

вив координаты, градус поворота, шрифт, кегль и выравнивание в со-

ответствии с рисунком. 

 

31. Выполните сохранение созданной рамки. 
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32. Выполните установку созданной рамки. Для этого нажмите 

Design > Sheet Templates > Local > Manage Templates. 

 

33. Откройте папку, в которой хранятся рамки, нажатием на 

кнопку . 

 

34. Поместите в открывшуюся папку созданную на предыдущих 

шагах рамку и закройте проводник. 

35. Обновите список нажатием на кнопку . 

 

36. В списке появится добавленная рамка. Нажмите на нее правой 

кнопкой мыши и выберите опцию Set as Default. 

 

37. Нажмите кнопку Apply . 

38. Оформите отчет. 

39. Защитите работу. 

 

Контрольные вопросы  

 

1. Как изменится рамка листа при работе с форматом А2? 

2. Почему все надписи в итоговом документе выполнены не по 

ГОСТу? 

3. Для каких видов документов может применяться созданная 

рамка? 
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Лабораторная работа № 5 

РАЗРАБОТКА СХЕМЫ ЭЛЕКТРИЧЕСКОЙ ПРИНЦИПИАЛЬНОЙ 

 

Цель работы: изучение алгоритма работы по созданию электри-

ческих принципиальных схем в Altium Designer. 

Задание на лабораторную работу: по методическому примеру 

разработать электрическую принципиальную схему генератора, управ-

ляемого напряжением, выполненную в соответствии с требованиями 

ГОСТа. 

 

Ход работы 

 

1. Откройте программу Altium Designer. 

2. Откройте ранее созданный проект. 

3. Получите у преподавателя библиотеки, необходимые для ра-

боты, в формате сжатой папки. 

4. Распакуйте содержимое папки. 

5. Установите интегрированные библиотеки. 

5.1. Откройте файл схемы. 

5.2. На панели инструментов выберите Place Part . 

5.3. Нажмите кнопку . В открывшемся окне выберите опцию 

File-based Libraries Preferences. 

 

5.4. Нажмите на кнопку Install . Выберите все имеющи-

еся библиотеки и нажмите «Открыть». 

6. Библиотеки установлены, и компоненты в их составе могут 

быть использованы при работе. Однако до размещения компонентов 

необходимо настроить рамку листа. Для этого, находясь в рабочем про-

странстве схемы, нажмите Design > Sheet Templates > Local >  

> A3_GOST. 
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7. В открывшемся окне установите галочку, которая добавит в 

документ параметры рамки, созданные в предыдущей лабораторной 

работе. 

 

8. Нажмите OK. 

9. Заполните пустые поля рамки. Для этого перейдите во 

вкладку Properties, выберите пункт Parameters. 

10. Введите нужные параметры. 

10.1. Свои фамилию и инициалы – в пункте «Разработал». 

10.2. Фамилию и инициалы преподавателя – в пунктах «Прове-

рил», «Нормоконтроль», «Утвердил». 

10.3. Децимальный номер при выполнении учебных работ запи-

сывается по образцу «ВлГУ.11.02.17.РЭсп-123.01.0.00 Э3». Первый 

идентификатор – образовательная организация, второй – код специаль-

ности обучающегося, третий – учебная группа, четвертый – двузнач-

ный порядковый номер обучающегося по списку, пятый – код вида ра-

бот (0), шестой – двузначный номер документа (00), седьмой – вид до-

кумента (в данном случае Э3 – схема электрическая принципиальная). 

10.4. Название схемы – ГУН (генератор, управляемый напряже-

нием). 

10.5. Подписи – «Схема электрическая принципиальная». 

10.6. Номер листа и их общее количество – 1. 

 

11. Таким образом, основная надпись примет следующий вид. 
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12. Теперь можно перейти к непосредственному размещению 

символов компонентов. Для этого нажмите на инструмент Place Part. 

Выберите библиотеку «3_Конденсаторы». В открывшемся списке вы-

берите элемент 0402 и разместите девять конденсаторов в рабочей об-

ласти. На данном этапе расположение элементов не имеет значения. 

 

13. Аналогичным образом разместите восемь резисторов типо-

размера 0402, четыре дросселя типоразмера 0603, два транзистора типа 

BFR93A, два варикапа BB181, 115 (библиотека – полупроводниковые 

приборы). 

14. Разместив все символы-компоненты в рабочей области, рас-

положите их как на рисунке. Для поворота компонентов используйте 

клавишу «Пробел». 
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15. Далее необходимо соединить компоненты. Для этого восполь-

зуйтесь инструментом Place Wire . Наведите курсор на точку элек-

трической привязки символа компонента. Нажмите левую кнопку 

мыши.  

 

16. Проведите соединение до точки электрической привязки дру-

гого компонента. Нажмите левую кнопку мыши. 

 

17. Аналогичным образом выполните соединение всех компонен-

тов как на рисунке. Для изменения угла соединения используйте кла-

вишу «Пробел». 
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18. Далее на схему необходимо добавить общий провод. Для 

этого воспользуйтесь инструментом Place GND Power Port . 

19. Перед размещением элемента на схеме перейдите в режим ак-

тивной паузы, скройте отображение подписи и измените параметр Style 

на Bar. 

 

20. Разместите семь таких символов и соедините их со схемой. 

 

21. Далее на схему необходимо добавить таблицу соединений. 

Для этого разместите компоненты KONT_5x25_Head и KONT_5x25, 

находящиеся в библиотеке «Соединители». 

 

22. Разместите в рабочей области программы таблицу следую-

щего вида. 
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23. Пронумеруйте контакты таблицы соединений и обозначьте их 

«Uупр» и «Общий». Затем соедините таблицу со схемой в соответствии 

с рисунком. 

 

24. Добавьте на схему еще одну таблицу соединений с цепями 

Uпит и Uвых. 

25. После того как все компоненты будут размещены, необхо-

димо выполнить их нумерацию. Для этого перейдите во вкладку  

Tools > Annotation > Annotate Schematics. 

 

26. В открывшемся окне необходимо выбрать порядок нумера-

ции. Для этого в пункте Order of  Processing выберите опцию Down 

Then Across. 
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27. Нажмите на кнопку Update Changes List. 

. 

28. Нажмите на кнопку Accept Changes (Create ECO). 

 

29. В появившемся окне сначала выполните проверку вносимых 

изменений (кнопка Validate Changes). 

 

30. После проверки нажмите кнопку Execute Changes. 

 

31. Таким образом, все компоненты схемы будут пронумерованы.  

 

32. Для сохранения схемы в формате PDF воспользуйтесь комби-

нацией клавиш Ctrl + P клавиатуры. В открывшемся окне выберите оп-

цию Microsoft Print to PDF. 

 

33. Нажмите Print  и выберите путь, по которому будет со-

хранен итоговый файл. 

34. Оформите отчет. 

35. Защитите работу. 
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Контрольные вопросы 

 

1. За что отвечает каждый из идентификаторов децимального но-

мера? 

2. Для чего предназначено поле «Нормоконтроль» в основной 

надписи? 

3. Можно ли вместо автоматической нумерации компонентов вы-

полнить ручную? 

4. Что такое ЕСКД? 

5. Для чего в схеме нужна таблица соединений? 

 

Лабораторная работа № 6 

ТРАССИРОВКА ПЕЧАТНОЙ ПЛАТЫ 

 

Цель работы: изучение алгоритмов работы с редактором печат-

ных плат в Altium Designer. 

Задание на лабораторную работу: по методическому примеру 

разработайте печатную плату. 

 

Краткие теоретические сведения 

 

Создание печатной платы в Altium Designer необходимо начинать 

с настройки правил. Правила (Design Rules) – это набор условий и 

ограничений, которые определяют, как должна быть спроектирована 

печатная плата в соответствии с различными техническими и техноло-

гическими требованиями. Правила определяют минимальные зазоры 

между проводниками и компонентами, минимальную и максимальную 

ширину дорожек, размеры переходных отверстий и пр. Каждое из пра-

вил можно настроить вручную. Например, на экране показано окно 

правил, в левой части которого приведен полный список имеющихся 

правил, а в правой – настройка минимального расстояния между объ-

ектами разных типов.  
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Помимо ручной последовательной настройки каждого правила 

существует возможность импортировать заранее сохраненный набор 

правил. 

Следующий важный шаг при создании печатной платы –  

настройка стека слоев, из которых состоит печатная плата. На данном 

этапе определяются тип диэлектрика и его толщина, число слоев пе-

чатной платы и пр. 

Трассировка печатной платы – это процесс создания электри-

ческих соединений между компонентами на печатной плате с помо-

щью проводящих дорожек. Основная цель трассировки – обеспечение 

электрического соединения между компонентами, однако с ростом 

сложности разрабатываемого устройства необходимо учитывать до-

полнительные аспекты, например нагрев компонентов и паразитные 

параметры проводящих дорожек. Особо жесткие требования предъяв-

ляют к трассировке аппаратуры, работающей в СВЧ-диапазоне. 

В простейшем случае соединение компонентов происходит на 

поверхности печатной платы. При этом печатные дорожки не должны 

пересекаться между собой. Поэтому зачастую прибегают к двусторон-

ней структуре печатной платы, когда одна часть соединений осуществ-

ляется на одной стороне платы, а другая – на обратной. При этом элек-

трическое соединение между слоями обеспечивается сквозными ме-

таллизированными отверстиями. 
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При размещении питания (VCC) и земли (GND) на печатных пла-

тах во многих случаях используют полигоны, представляющие собой 

большую, сплошную область проводящего материала, которая покры-

вает значительную часть платы и обеспечивает легкое соединение с об-

щими сетями. 

 

Ход работы 

 

1. Откройте программу Altium Designer. 

2. Откройте ранее созданный проект. 

3. Получите у преподавателя файл с правилами проектирования, 

необходимый для работы. 

4. Для перехода к настройкам правил проектирования печатной 

платы нажмите Design > Rules. 

 

5. В открывшемся окне нажмите правой кнопкой мыши на любое 

из правил в списке и выберите опцию Import Rules. 

 

6. В появившемся окне сначала нажмите комбинацию клавиш 

Ctrl + A для выделения всех правил в списке, а затем – кнопку OK. 
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7. В открывшемся проводнике укажите путь к файлу с правилами 

и откройте его.  

8. В открывшемся окне подтвердите замену существующих пра-

вил по умолчанию на импортируемые. Для этого нажмите на 

кнопку Yes. 

 

9. Затем нажмите кнопку Apply  и закройте окно правил. 

10. Произведите настройку стека слоев. Для этого нажмите  

Design > Layer Stack Manager. 

 
11. По умолчанию плата состоит из двух поверхностных слоев, ко-

личество которых может быть увеличено, однако для разрабатываемой 

печатной платы двух слоев достаточно. Единственным вносимым из-

менением станет установка толщины диэлектрика – 1,5 мм.  

 

12. После установки толщины диэлектрика сохраните структуру 

слоев в дереве проекта, нажав по нему правой кнопкой мыши и выбрав 

пункт Save to PCB. 

 

13. После выполнения подготовительных действий можно пе-

рейти к созданию печатной платы. Сначала необходимо задать контур 

платы. Для этого перейдите к слою Mechanical 1 . 
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14. Используя инструмент Place Line , начертите в рабочей об-

ласти прямоугольник размером 15 × 15 мм. 

15. Далее необходимо ограничить размеры рабочей области до 

размеров платы. Для этого выделите контур платы и нажмите  

Design > Board Shape > Define Board Shape from Selected Object. 

 

16. После этого необходимо передвинуть начало координат в ле-

вый нижний угол платы. Для этого нажмите Edit > Origin > Set. Наве-

дите курсор на обозначенное место и нажмите левую кнопку мыши. 

 

17. После выполнения предыдущих шагов рабочее пространство 

должно выглядеть следующим образом. 
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18. Для переноса компонентов со схемы электрической принципи-

альной на печатную плату нажмите на Design > Import Changes From * 

 

19. В открывшемся окне выполните проверку вносимых измене-

ний (кнопка Validate Changes ). Если ошибок не обнаружено, 

то изменения можно применить (кнопка Execute Changes ). 

20. В рабочей области появились все компоненты со схемы и ком-

ната. Для дальнейшей работы комната не понадобится, поэтому ее 

можно удалить, сначала нажав по ней левой кнопкой мыши, а затем 

нажав клавишу Del клавиатуры. 

 

21. Перед непосредственным размещением компонентов на плате 

будет целесообразно уменьшить размер шелкографии в условиях ра-

боты с платой малых размеров. Для этого нажмите на обозначение лю-

бого компонента. 

 

22. Нажмите на выбранный объект правой кнопкой мыши и вы-

берите команду Find Similar Object, которая поможет выделить объ-

екты данного типа. 

23. В открывшемся окне нажмите на кнопку OK. Таким образом, 

все подписи компонентов окажутся выделены. 
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24. Перейдите во вкладку Properties. В ней настройте высоту тек-

ста (Text Height) 0.2 мм и ширину текста (Text Width) 0.05 мм. 

25. Затем необходимо разместить компоненты на поверхности 

печатной платы. Для облегчения этого процесса серыми линиями по-

казаны соединения между контактными площадками компонентов. 

Расположите компоненты как на рисунке, при необходимости пользу-

ясь табл. 3. 

 

Таблица 3 

Координаты компонентов на поверхности печатной платы 

Компонент 
Коорди-

ната X 

Коорди-

ната Y 
Компонент 

Коорди-

ната X 

Коорди-

ната Y 

C1 1.60 1.50 R1 7.60 1.50 

C2 5.00 4.90 R2 1.00 4.80 

C3 2.50 13.50 R3 1.00 8.40 

C4 6.10 6.20 R4 2.80 10.80 

C5 8.50 4.90 R5 7.90 6.20 

C6 3.65 13.50 R6 10.40 10.80 

C7 8.50 7.60 R7 8.80 12.00 

C8 14.00 7.30 R8 6.15 12.00 

C9 4.80 13.50 VD1 7.40 3.20 

L1 2.80 3.20 VD2 10.60 1.50 

L2 2.80 6.50 VT1 6.65 7.50 

L3 8.80 8.90 VT2 10.40 5.70 

L4 12.20 11.50 – – – 
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26. После размещения компонентов на плате необходимо соеди-

нить их, используя инструмент Interactively Route Connections . Со-

едините центры контактных площадок, избегая прямых углов. Для из-

менения типа углового соединения используйте клавиши Shift + Space.  

 

27. Для проведения сети GND воспользуемся полигонами. Для 

этого выберите инструмент Polygon Pour . Начертите область, охва-

тывающую контактные площадки сети GND. 
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28. Перейдите в параметры полигона (вкладка Properties) и выбе-

рите соответствующую сеть. 

 

29. Аналогичным образом разместите на поверхности платы еще 

четыре полигона. 

 

30. Для обеспечения электрической связи между полигонами 

необходимо использовать обратную сторону печатной платы. Для 

этого переключитесь на слой Bottom Layer. 
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31. Находясь на нижнем слое, начертите полигон по всей поверх-

ности печатной платы и также подключите его к сети GND. 

32. Когда все полигоны начерчены, их необходимо залить. Для 

этого нажмите Tools >Polygon Pours > Repour All. 

 

33. После выполнения описанных действий значительная часть 

платы оказывается покрыта сплошными медными слоями, однако по-

лупрозрачные линии указывают на то, что соединения между этими об-

ластями все еще нет. 

 

34. Для обеспечения проводимости полигоны на верхнем и нижнем 

слоях необходимо соединить с помощью сквозных металлизированных 

отверстий. Для этого воспользуйтесь инструментом Place Via . Перед 

размещением отверстия перейдите в режим активной паузы и выберите 

сеть GND для отверстия. 



74 

35. Разместите переходные отверстия на поверхности платы в об-

ластях полигонов. 

 

36. Печатная плата полностью готова. Как и при создании поса-

дочных мест, нажатием на клавишу «3» клавиатуры можно перейти к 

трехмерному отображению печатной платы. 
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37. Для изготовления платы необходимо подготовить комплект до-

кументов, называемый гербер-файлами. Гербер-файлы – это файлы, со-

держащие информацию о слоях печатной платы, выполненные в универ-

сальном формате для работы с любым оборудованием. Для генерации 

этих файлов нажмите File > Fabrication Outputs > Gerber Files. 

 

38. В окне General установите миллиметры в качестве единицы 

измерения. 

 

39. В окне Layers необходимо указать слои, информацию о кото-

рых будут содержать гербер-файлы. Выберите четыре файла: Top 

Layer, Bottom Layer, Top Overlay, Mechanical 1.  

 

40. После этого нажмите кнопку OK. 
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41. В дереве проекта появится файл формата *.Cam, который 

необходимо сохранить в папке проекта. 

 

42. В дереве проекта также появится папка Generated, хранящая 

гербер-файлы каждого из слоев платы. 

 

43. Также для производства необходимо отдельно подготовить 

файл сверловки, содержащий в себе информацию о размерах и распо-

ложении отверстий. Для этого нажмите File > Fabrication Outputs > 

> NC Drill Files. 

 

44. В открывшемся окне переведите единицы измерения с милов 

на миллиметры и нажмите OK. 

45. В результате дерево проектов пополнится еще одним файлом 

формата *.Cam. Сохраните его. 

46. Оформите отчет. 

47. Защитите работу. 
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Контрольные вопросы 

 

1. Что такое полигон? 

2. Что такое гербер-файлы? 

3. Для чего используют сквозные металлизированные отверстия? 

4. Что устанавливают правила проектирования печатной платы? 

 

Лабораторная работа № 7 

ВЫПОЛНЕНИЕ ЧЕРТЕЖЕЙ 

 

Цель работы: изучение алгоритмов работы с редактором черте-

жей в Altium Designer. 

Задание на лабораторную работу: по методическому примеру 

разработать сборочный чертеж и чертеж печатной платы генератора, 

управляемого напряжением. 

 

Краткие теоретические сведения 

 

Сборочный чертеж печатной платы – это технологический до-

кумент, используемый для того, чтобы показать, как должна быть со-

брана печатная плата с установленными на ней электронными компо-

нентами. Этот чертеж – важная часть проектной документации, служа-

щая руководством для сборщиков и тестировщиков. 

Сборочный чертеж показывает, где и как должны быть установ-

лены все компоненты на печатной плате, включая ориентацию и по-

лярность. Также чертеж содержит обозначения компонентов, связыва-

ющие их с компонентами в спецификации. 

Чертеж печатной платы – это технологический документ, кото-

рый представляет собой детализированное изображение конструкции 

печатной платы, показывающее расположение всех проводников, кон-

тактных площадок, отверстий и других элементов, необходимых для ее 

производства. Этот чертеж используют для изготовления печатной 

платы. 

Чертеж печатной платы отображает физическую конфигурацию 

платы, включая ее размеры, форму, слои, показывает расположение 

всех переходных отверстий. 
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Ход работы 

1. Откройте программу Altium Designer. 

2. Откройте ранее созданный проект. 

3. Получите у преподавателя файл с рамкой для чертежей. 

4. Добавьте к проекту новый файл формата чертежа (Add New  

to Project > Draftsman Document).  

 

5. В открывшемся окне нажмите кнопку Templates . 

6. В окне шаблонов с рамками нажмите на кнопку , чтобы пе-

рейти в директорию, в которой хранятся соответствующие файлы. 

7. Скопируйте в открывшуюся папку рамку GOST_A3.DwsDot. 

8. Закройте список с шаблонами. 

9. В окне создания нового документа убедитесь, что в пункте Pro-

ject указан верный проект, а пункт Document оказался связан с ранее 

разработанной печатной платой. После этого, не изменяя прочие пара-

метры, нажмите OK. 

 

10. Сохраните документ в директории проекта, назвав его «Сбо-

рочный чертеж». 
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11. Примените к документу ранее сохраненную рамку. Для этого 

перейдите во вкладку Properties. Выберите пункт Page Options. Выбе-

рите способ, которым будет задаваться рамка, – Template. В появив-

шемся списке выберите A3_GOST. 

 

12. Заполните основную надпись. 

13. Разместите проекцию платы, используя инструмент Insert 

Board Assembly View . 

14. Перейдите к параметрам размещенного объекта, дважды 

нажав по нему левой кнопкой мыши. 

15. Установите подходящий масштаб (8:1). 

 

16. Скройте отображение подписи, нажав на значок глаза. 

 

17. Скройте контактные площадки, перейдя к списку компонен-

тов нажатием на кнопку . 

18. Выберите отображение всех компонентов. 

 



80 

19. Снимите галочки отображения со всех контактных точек. 

 

20. Укажите размеры платы, используя инструмент Insert New 

Linear Dimension . 

21. С помощью данного инструмента выделите нужную сторону 

платы и нажмите по ней левой кнопкой мыши. 

 

22. Разместите стрелку с размерами на расстоянии не менее 10 мм 

от платы. 
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23. Перейдите к параметрам этой стрелки. 

24. Измените цвет линий на черный. 

 

25. Измените формат текста таким образом, чтобы он был над 

стрелкой, а не внутри нее. 

 

26. Скройте отображение единиц измерения. 

 

27. Измените шрифт на наклонный GOST type A. 

 

28. Поскольку на сборочном чертеже размеры платы приводятся 

для справок, после них необходим суффикс *. 

 

29. Аналогичным образом добавьте на чертеж размеры боковой 

стороны платы. 
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30. Далее необходимо разместить проекцию платы с видом слева. 

Повторите пункты 13 – 16. Выберите, в каких координатах построить 

проекцию. 

 

31. Добавьте на чертеж толщину платы и расстояние от левого 

края до самого высокого компонента. 

 

32. Разместите на чертеже изометрический вид платы. Для этого 

нажмите Place > Additional Views > Board Isometric View. 
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33. Скройте подпись проекции, установите масштаб и сориенти-

руйте ее как на рисунке. 

 

34. Расположите все проекции на одной линии. 

 

35. Помимо изображений сборочный чертеж должен содержать 

текстовую информацию, расположенную сверху над основной надпи-

сью. Для размещения текстовой информации воспользуйтесь инстру-

ментом Place Text. 

 

36. В тексте необходимо отразить справочный характер размеров, 

способ установки компонентов на плату, используемый припой. 
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37. Каждый из вариантов установки необходимо показать на чер-

теже. Для этого воспользуйтесь инструментом Insert Component 

View . 

38. В качестве подписи укажите «Установка C1-C9, R1-R7,  

L1-L4, VD1, VD2». 

39. Измените шрифт подписи. 

 

40. В качестве отображаемого компонента выберите любой из 

дросселей. 

 

41. Аналогичным образом разместите вариант установки для 

транзисторов. 
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42. Создайте чертеж печатной платы. Для этого добавьте в дерево 

проекта новый файл формата Draftsman Document. 

43. Сохраните документ. 

44. Аналогично пунктам 11 и 12 примените к документу рамку и 

заполните ее. 

45. Разместите проекцию платы, скройте ее подпись и установите 

масштаб 5:1. 

46. Добавьте отображение топологии на проекции платы. 

 

47. Скройте отображение компонентов. 

 

48. Разместите на чертеже размеры платы аналогично пунктам  

20 – 28. 

49. Далее к проекции платы необходимо добавить координатную 

сетку. Для этого воспользуйтесь инструментом X, Y Axis Scale. 
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50. Разместите начало отсчета в левом нижнем углу платы. 

 

51. Доведите линейку до противоположного края платы. 

 

52. Перейдите в параметры линейки. Измените ее цвет, шрифт, а 

также установите девять добавочных значений. 

 

53. Добавьте линейку к левой стороне платы. 
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54. Поскольку трассировка платы производилась с двух сторон, 

на чертеже необходимо также показать обратную сторону платы. Для 

этого повторите пункты 44 – 52, изменив отображаемую сторону и по-

вернув плату. 

 

55. Добавьте проекцию платы слева без отображения компонен-

тов, укажите толщину платы. 

56. Также дополнительно на чертеже необходимо показать все от-

верстия. Для этого воспользуйтесь инструментом Drill Drawing View. 

 

57. Разместите рисунок сверловки, отмасштабируйте его и 

скройте подпись. 

58. Также к рисунку сверловки необходимо добавить таблицу, по-

ясняющую символы отверстий. Для этого воспользуйтесь инструмен-

том Drill Table. 

 

59. Измените подпись к таблице на «Таблица 1», а также изме-

ните шрифт на Gost Type A. 
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60. Также измените шрифт основного текста в таблице. 

 

61. Скройте отображение единиц измерения. 

62. В пункте Columns измените текст отображаемых столбцов на 

русский. 

 

63. Последним шагом на чертеж печатной платы необходимо до-

бавить текстовую информацию, указывающую способ изготовления 

печатной платы, шаг координатной сетки, ширину проводников и рас-

стояние между ними, а также дающую ссылку на таблицу отверстий и 

указывающую класс точности. 
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64. Таким образом, чертеж печатной платы может считаться за-

конченным. 

 

65. Сохраните оба чертежа в формате PDF. 

66. Оформите отчет. 

67. Защитите работу. 

 

Контрольные вопросы 

1. Для чего используют сборочные чертежи? 

2. Для чего используют чертежи печатных плат? 

3. Какая текстовая информация должна быть отражена на сбороч-

ном чертеже? 

4. Какая текстовая информация должна быть отражена на чер-

теже печатной платы? 

5. Что такое вариант установки компонента? 
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ЗАКЛЮЧЕНИЕ 

 

В лабораторном практикуме рассмотрен полный типовой процесс 

проектирования радиоэлектронного изделия. Описаны различные пути 

создания и интеграции библиотек компонентов. Рассмотрена работа с 

редактором схем, в том числе оформление основной надписи согласно 

требованиям ГОСТа. Описан процесс проектирования простой двух-

сторонней низкочастотной печатной платы. Рассмотрены способы под-

готовки и экспорта выходной документации, в том числе и чертежей. 

Курс лабораторного практикума позволяет познакомиться с 

САПР Altium Designer, получить понимание структуры проекта и важ-

ности связей между его отдельными документами, а также приобрести 

навыки разработки библиотек УГО и посадочных мест, схемотехниче-

ского проектирования, трассировки печатных плат. 

  



91 

 

 

 

БИБЛИОГРАФИЧЕСКИЙ СПИСОК 

 

1. ГОСТ 2.743-1991 Единая система конструкторской документа-

ции. Обозначения условные графические в схемах. Элементы цифро-

вой техники. – М. : Изд-во стандартов, 1991. – 65 с. 

2. Документация Altium Designer [Электронный ресурс]. – URL: 

https://www.altium.com/ru/documentation/altium-designer (дата обраще-

ния: 28.08.2024). 

3. Приходько, Д. В. Учебно-методическое пособие по работе с 

библиотеками в Altium Designer : учеб. пособие / Д. В. Приходько,  

А. А. Айрапетян ; Моск. ин-т электрон. техники. – М. : Издат.-полиграф. 

комплекс МИЭТа, 2022. – 180 с. – ISBN 978-5-7256-0985-1. 

4. Лопаткин, А. Проектирование печатных плат в Altium Designer / 

А. Лопаткин. – М. : ДМК Пресс, 2016. – 400 с. – ISBN 978-5-97060-337-6. 

5. Ванин, Д. А. Разработка баз данных принципиальных электри-

ческих схем и макетов печатных плат c использованием программного 

обеспечения Altium Designer : учеб. пособие / Д. А. Ванин, Д. А. Сидо-

ренко. – М. : Изд-во РУТ (МИИТ), 2021. – 165 с. 

 

 

 

 

 

 

 

 

 

 

 

 

 



92 

 

 

 

 

 

 

 

 

 

 

 
 

 

Учебное электронное издание 

 

КРАМАРЕНКО Никита Игоревич 

 

ОСНОВЫ КОНСТРУИРОВАНИЯ ЭЛЕКТРОННЫХ СРЕДСТВ 

 

Лабораторный практикум 

 

Редактор Е. А. Платонова 

Технический редактор Ш. Ш. Амирсейидов 

Компьютерная верстка Л. В. Макаровой 

Корректор Н. В. Пустовойтова 

Выпускающий редактор А. А. Амирсейидова 

 

Системные требования: Intel от 1,3 ГГц; Windows XP/7/8/10; Adobe Reader; 

дисковод CD-ROM. 

 

Тираж 9 экз. 

 

Владимирский государственный университет 

имени Александра Григорьевича и Николая Григорьевича Столетовых 

Изд-во ВлГУ 

rio.vlgu@yandex.ru 

 

Институт информационных технологий и электроники 

кафедра радиотехники и радиосистем 

nikitakramarenko889@gmail.com 

 


